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Today’s Hosts

JAMES HAMMER BEVERLY SNYDER

EMPLOYER SERVICES DIRECTOR COMPLIANCE MANAGER
James.hammer@urs.or
801-36607786

801-366-7493

Trust - Commitment

Value - Innovation - Excellence URS

Utah Retirement Systems
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Advanced Utah Retirement End User System
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What to Expect

» Access to more reports and information
» Enrollment and payroll files will be validated at submission

» Payroll changes delivered regularly and ad-hoc

¥BAUREUS @&URS
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What to Expect

» Timeline:
» Going live Winter 2024
» March 2020: COVID-19 and Magna earthquake — 3 years ago
> Need your help:
» Data Conditioning
» Building AUREUS Employer Files

¥RAUREUS ®&URS
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What to Expect

» Data Conditioning:
» Log into the URS Employer Portal
» Terminate old records
» Add verification of termination info to Batch Term File
» Promptly respond to requests for information

» Ad-hoc updates to member records

¥RAUREUS ®&URS
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What to Expect

» AUREUS Employer Files:
» Meetings and webinars are ongoing with IT staff and vendors
> Before February 2024
» Build the Employment File and Payroll Reporting File
» Build Payroll Changes and Tier 2 Change Reports

» Reminder: Include all employees who are on the payroll

¥RAUREUS ®&URS
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What to Expect: Online

» QOrganization Information, Contacts, etc.
» Employment Life Cycle
» Contributions and Adjustments

» Queries and Reports

¥BAUREUS @&URS
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What to Expect: Files

» Employment File » Employee Roster Lookup Report
» Payroll Reporting File » Employer Transaction Report
» Payroll Changes Report » Payroll Detail Lookup Report
» Tier 2 Change Report » Tier 2 Election Status Report

)

v

DC Participant and Loan Report

¥RAUREUS ®&URS
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Title 49

Utah State Retiremen
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Legislative Changes
Where Can I Find Them?

B Home | Utah Legislature X 4+

< C (O @& hitps//leutah.gov Q@ w O a

Legistators Bills Commitices

https://le.utah.gov

UTAH STATE LEGISLATURE

Search le.utah.gov

{ ) February 14, 2023 View Week

View Month

s M T W T F S i =
An E|®

. ‘ . 4 House Revenue and Taxation Committee
00000
00000
» 9000
=@ @

«

L~

,..
I~}
@

G&URS

Utah Retirement Systems

o
e}

Senate Education Committee <

Today




Know Your Representatives
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Utah Code 49-11-102

Definitions

( ) 4 )

ALLOWANCE THE PENSION PLUS THE ANNUITY

7
\

TOTAL AMOUNT PAID BY PARTICIPATING EMPLOYER

CONTRIBUTIONS

—
——
—
o INTO A SYSTEM
i VEMBER ) o [ A PERSON WITH CONTRIBUTIONS ON DEPOSIT )

I WITH A SYSTEM

VOLUNTARY B AMOUNT CONTRIBUTED BY A PARTICIPANT INTO A

DEFERRALS — MEMBERS’ DEFINED CONTRIBUTION ACCOUNT

®&URS
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Utah Codes

For Your Reference

Utah Code 49-11-201
Utah Code 49-11-202
Utah Code 49-11-203
Utah Code 49-11-204
Utah Code 49-11-205

Establishment of Retirement Office
Establishment of Utah State Retirement Board
Powers and Duties of the Board

Powers and Duties of the Executive Director
Membership Council Established

®&URS
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Utah Codes

For Your Reference

Part3 Investment Fund
Utah Code 49-11-301
Utah Code 49-11-302
Utah Code 49-11-303
Utah Code 49-11-304
Utah Code 49-11-305
Utah Code 49-11-306
Utah Code 49-11-307

Creation

Board Duties With Respect to the Fund
Fund Investment Standard
Administrative Costs

Self-Insurance Options

Definitions

Report on Funded Status

®&URS
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Utah Code 49-11-401

Transfer of Service Credits

( )

MEMBER DOES NOT LOSE SERVICE CREDIT WHEN
TRANSFERRING BETWEEN RETIREMENT SYSTEMS

SERVICE WILL BE TRANSFERRED BASED UPON
TERMS AND CONDITIONS ESTABLISHED BY THE BOARD

AGE, YEARS OF SERVICE, SALARY, REQUIREMENTS OF SYSTEM

7
\

MEMBER SHALL RETIRE FROM SYSTEM
MOST RECENTLY COVERED BY

MEMBER MAY NOT PORT SERVICE UNTIL RETIREMENT
®URS

Utah Retirement Systems




Utah Code 49-11-402

Purchase of Military Service Credit

( )

NOTWITHSTANDING THE PROVISIONS OF USERRA

OFFICIAL CALL TO FULL-TIME UNITED STATES MILITARY SERVICE

MEMBER AND PARTICIPATING EMPLOYER JOINTLY
SHALL MAKE REQUIRED PAYMENTS

7
J AL

REQUIRED PAYMENTS MUST BE MADE
PRIOR TO MEMBERS RETIREMENT DATE

PAYMENTS REQUIRED DURING TIME OF MILITARY SERVICE,
 ORAFTER THE MILITARY SERVICE (WITHIN A SPECIFIC TIME PERIOD) | URS

Utah Retirement Systems




Utah Code 49-11-403

Purchasing Service Credit Not Otherwise Qualifying

i 1 [  COVEREDBY PLAN OFFERED BY ENTITY |
; UNITED STATES FEDERAL EMPLOYMENT ] | DESIGNATED BY UTAH BOARD OF HIGHERED
" EMPLOYMENT IN PRIVATE U.S.-BASED SCHOOL, IF | [ THE PERIOD OF TIME FOR WHICH A
| RECEIVED EMPLOYER-PAID RETIREMENT BENEFIT | | DISABILITY BENEFITS WERE PAID

' PUBLIC EMPLOYMENT IN ANOTHER 1 [ EMPLOYMENT IN A CHARTER SCHOOL LOCATED
; U.S. STATE/TERRITORY J WITHIN THE STATE )
" FORFEITED SERVICE CREDITIFMEMBER | [ MEMBER CHOSE TO EXEMPT FROM COVERAGE

. DOES NOT QUALIFY FORANALLOWANCE | | AND FORFEITED BENEFIT )
: FULL-TIME PUBLIC SERVICE WHILE 1 [ MEMBER MUST HAVE FOUR YEARS OF SERVICE

k ON APPROVED LEAVE OF ABSENCE J PRIOR TO MAKING PURCHASE )

®&URS

Utah Retirement Systems




Utah Code 49-11-404

Benefit Protection Contract Authorized

( )

EMPLOYER MAY ESTABLISH A SALARY PROTECTION PROGRAM

MEMBERS ARE PAID DURING PERIODS OF DISABILITY

EMPLOYER MAY ENTER INTO BENEFIT
PROTECTION CONTRACT WITH URS

7
\

SALARY PROTECTION PROVIDES BENEFITS BASED ON
RATE OF COMPENSATION AT TIME OF DISABILITY

WILL PAY BENEFITS OVER TIME OF DISABILITY
k | ®URS

Utah Retirement Systems




Utah Code 49-11-405

Service Credit From Different Systems

4 )

FOR PURPOSES OF DETERMINING ELIGIBILITY FOR RETIREMENT,
A MEMBER MAY COMBINE SERVICE CREDIT IF THEY HAVE:

SERVICE CREDIT FROM TWO OR MORE SYSTEMS
OR

SERVICE CREDIT FROM ONE OR MORE SYSTEMS AND
THE UTAH GOVERNORS’ AND LEGISLATORS’ RETIREMENT PLAN

- /

-

®URS

Utah Retirement Systems
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Utah Code 49-11-501
Refunds of Member Contributions

UPON TERMINATION (EXCEPT RETIREMENT, DISABILITY, OR DEATH),
MEMBER MAY LEAVE THE MEMBER CONTRIBUTIONS IN THE FUND
OR MAY RECEIVE A REFUND

REFUNDS NOT MADE WITHIN 60 DAYS FROM
LAST CONTRIBUTIONS BEING MADE

-
\

MEMBER IS NOT ELIGIBLE FOR REFUND IF RE-EMPLOYED
WITH ANOTHER PARTICIPATING EMPLOYER WITHIN 60 DAYS

Lo

®URS
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Utah Code 49-11-502

Redeposits of Retunds
4 )
IF MEMBER RECEIVES A REFUND OF MEMBER CONTRIBUTIONS
AND

IS SUBSEQUENTLY RE-EMPLOYED IN A POSITION COVERED BY SYSTEM:

THE PARTICIPATING EMPLOYER OR MEMBER MAY REDEPOSIT
AN AMOUNT EQUAL TO THE REFUNDED MEMBER CONTRIBUTIONS

\_ S

-

®URS

Utah Retirement Systems
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Utah Code 49-11-504

Reemployment of a Retiree — Hired Prior to July 1, 2010

(

RETIREE IS NOT SUBJECT TO POST-RETIREMENT RESTRICTIONS

MAY NOT EARN ANY ADDITIONAL SERVICE CREDITS

\ .
4 )
MAY NOT RECEIVE RETIREMENT RELATED CONTRIBUTIONS EXCEEDING
THE NORMAL COST RATE
EMPLOYER-RELATED CONTRIBUTIONS MUST BE SUBMITTED

TO A QUALIFIED PLAN APPROVED BY THE BOARD (URS)

: “®URS

Utah Retirement Systems
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Utah Code 49-11-601

Payment of Employer Contributions

4 )

CONTRIBUTIONS REQUIRED WITHIN 30 DAYS OF THE END OF
THE PAY PERIOD

CONTRIBUTIONS MADE IN ERROR WILL BE REFUNDED
TO THE PARTICIPATING EMPLOYER OR MEMBER THAT
MADE THE CONTRIBUTION

DELINQUENT CONTRIBUTIONS SUBJECT TO
INTEREST AND PENALTY

L~

®URS
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Utah Code 49-11-602

Participating Employer to Maintain Records

MAINTAIN RECORDS NECESSARY TO CALCULATE RETIREMENT
BENEFITS AND VERIFY PROPER ADMINISTRATION

EMPLOYMENT SALARY/ TIME BENEFITS
PERIODS EARNINGS WORKED RECEIVED

{ MAINTAIN UNTIL THE EARLIEST OF: J

3 YEARS AFTER DATE OF RETIREMENT

3 YEARS AFTER THE DATE OF DEATH

®URS

Utah Retirement Systems

65 YEARS FROM THE DATE OF EMPLOYMENT

( N/ /[ )
s S
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Utah Code 49-11-603

Participating Employer to Report and Certi

7

AS SOON AS ADMINISTRATIVELY POSSIBLE

N\

NO LATER THAN 30 DAYS AFTER THE END OF EACH PAY PERIOD

MUST REPORT THE ELIGIBILITY FOR SERVICE CREDIT OF:

-

-

EACH
CURRENT
EMPLOYEE

\

¥

[ EACH NEW

EMPLOYEE
AS THEY BEGIN
EMPLOYMENT

-

~

)

r

§

ANY CHANGES

TO ELIGIBILITY

FOR SERVICE
CREDIT

~

P

(COMPENSATION\

FOR EACH
EMPLOYEE

®&URS
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Utah Code 49-11-603

Participating Employer to Report and Certi

( )

EACH PARTICIPATING EMPLOYER SHALL INCLUDE
A CERTIFICATION FOR EACH EMPLOYEE

CERTIFICATIONS ARE REQUIRED FOR:

ELIGIBLE EMPLOYEES

INELIGIBLE EMPLOYEES

RE-EMPLOYED RETIREES

ELECTED & APPOINTED EMPLOYEES

X Y[ ([
\ J\_J\ I\

®&URS
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Utah Code 49-11-604

Office Audits of Participating Employers

(

URS MAY PERFORM AN ON-SITE COMPLIANCE AUDIT TO
DETERMINE COMPLIANCE WITH REPORTING, CONTRIBUTION,
AND CERTIFICATION REQUIREMENTS

Y4
J\

URS MAY REQUEST RECORDS TO BE PROVIDED BY THE
PARTICIPATING EMPLOYER AT THE TIME OF THE AUDIT

\(
N\

AUDITS SHALL BE CONDUCTED AT THE SOLE DISCRETION OF
THE OFFICE AFTER REASONABLE NOTICE TO THE EMPLOYER

\(
I\

COMPLIANCE AUDITS ARE CONDUCTED EVERY 3-5 YEARS

-
.

®URS

Utah Retirement Systems




Utah Codes

For Your Reference

Utah Code 49-11-605
Utah Code 49-11-606
Utah Code 49-11-607
Utah Code 49-11-608
Utah Code 49-11-609
Utah Code 49-11-610
Utah Code 49-11-611
Utah Code 49-11-613

Notification and Correction of Violations

Full Participation

Determination of Benefits — Errors in Records or Calculations

False Statements or Records
Beneficiary Designations

Benefits Payable in Name of Beneficiary

Benefits and Money in the Fund Exempt From Taxation

Appeals Procedure

G&URS

Utah Retirement Systems




Utah Code 49-11-613.5

Limitation of Actions

4 )
ACTION REGARDING BENEFIT, RIGHT, OBLIGATION, OR
EMPLOYMENT RIGHT MAY ONLY BE COMMENCED WITHIN
FOUR YEARS OF DAY ON WHICH CAUSE ACCRUES

Y4
VAN

CAUSE OF ACTION ACCRUES, AND LIMITATION PERIOD
RUNS FROM THE DAY ON WHICH AGGRIEVED PARTY
BECAME AWARE, OR SHOULD HAVE BECOME AWARE, OF
THE FACTS GIVING RISE TO THE CAUSE OF ACTION

Lo

®URS
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Utah Codes

For Your Reference

Utah Code 49-11-614 through 49-11-1001

Vesting

Relinquishment

Election to Grandfather
Closing Retirement Accounts
Withdrawals

Tax Revenues

®&URS

Utah Retirement Systems




Utah Code 49-11-1101 &49-11-1102
Applicability

/ PUBLIC FINANCIAL INFORMATION \ /PUBLIC NOTICE OF ADMINISTRATIVE\

DISCLOSURE ON WEBSITE BOARD MEETINGS
URS SHALL PROVIDE FINANCIAL URS SHALL PROVIDE ADVANCE
INFORMATION AND PUBLIC NOTICE OF MEETINGS AND
EMPLOYEE COMPENSATION AGENDAS ON THE UTAH PUBLIC

\ / \ NOTICE WEBSITE /

Lo

®URS
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Utah Code 49-11-1201

Post-Retirement Reemployment Restrictions Act

7

RETIREE

N\

\

RE-EMPLOYED

RE-EMPLOYED

7

A MEMBER WHO HAS RETIRED FROM
A PARTICIPATING EMPLOYER

WORK OR SERVICE PERFORMED AFTER RETIREMENT
IN EXCHANGE FOR COMPENSATION

WORK OR SERVICE PERFORMED ON A CONTRACT

®&URS

Utah Retirement Systems



Utah Code 49-11-1203
Applicability

~N

DOES NOT APPLY TO EMPLOYMENT AS PART-TIME ELECTED OFFICIAL

. S

DOES NOT APPLY TO PART-TIME APPOINTED BOARD MEMBER WHO
RECEIVES NO REMUNERATION, STIPEND, OR OTHER BENEFIT

ONLY APPLIES IF AT LEAST
50 YEARS OLD (PS/FF), OR 55 YEARS OLD (PE)

®&URS

Utah Retirement Systems




Utah Code 49-11-1204

Election Following One-Year Separation

( )

A RETIREE MAY NOT EARN ADDITIONAL SERVICE CREDIT
AND RECEIVE THEIR RETIREMENT ALLOWANCE

A RETIREE MAY NOT RECEIVE ANY RETIREMENT-RELATED
CONTRIBUTIONS AND RECEIVE THEIR RETIREMENT ALLOWANCE

MUST BE CERTIFIED BY EMPLOYER

7
\

MUST BE REPORTED ON FILE

AMORTIZATION RATE DUE BASED ON EARNINGS AND FUND
®URS

Utah Retirement Systems




Utah Code 49-11-1205
Election 61 Days to One Year

THE RETIREE DOES NOT RECEIVE ANY EMPLOYER-PAID
BENEFITS INCLUDING INSURANCE AND PAID TIME OFF

N [
\

A RETIREE MAY NOT RECEIVE RETIREMENT SERVICE CREDIT
AND EMPLOYER-PAID SAVINGS CONTRIBUTIONS

A RETIREE DOES NOT EARN (IN A CALENDAR YEAR)
AN AMOUNT IN EXCESS OF THE INCOME LIMITATION

7
\

RETIREE MUST BE CERTIFIED AND
REPORTED ON CONTRIBUTION FILE

L~

®URS
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Utah Code 49-11-1205

Election Prior to 60 Days

( )

NO WORK CAN BE PERFORMED BY A RETIREE FOR
A FULL 60 DAYS FOLLOWING RETIREMENT DATE

IF RETIREE RETURNS WITHIN 60 DAYS,
RETIREMENT BENEFIT IS CANCELLED

RETIREMENT AMOUNT CAN BE RECALCULATED AFTER
TWO YEARS OF EMPLOYMENT — UPON REQUEST

7
\

EMPLOYER TO DETERMINE ELIGIBILITY, CERTIFY, AND REPORT

®&URS

Utah Retirement Systems




Utah Code 49-11-1205
Considered to Have Completed One Year

r

PUBLIC SAFETY
OFFICER

~\

r )
AFFILIATED

EMERGENCY SERVICE WORKER

SUFFERED PHYSICAL INJURY (QUALIFIED LTD)

AGE 50 (PS AND FF); AGE 55 (PE)

HAS LESS THAN 30 YEARS OF SERVICE

RETURNS TO WORK FOR DIFFERENT EMPLOYER

RECEIVES NO LONG-TERM DISABILITY

RETURNS WITHIN 1 YEAR OF RETIREMENT DATE

50 YEARS OF AGE

o Yon Yo Yo Y
T\

EARNINGS DO NOT EXCEED $500/MONTH

S Yo Yo Yo Yo Ve

RE-EMPLOYED BY DIFFERENT EMPLOYER

L

®&URS
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Utah Code 49-11-1205
Considered to Have Completed One Year

PART-TIME BOARD MEMBER, APPOINTED OR ELECTED

(~ =)
RETURNS WITHIN 1 YEAR OF RETIREMENT DATE

\ J

( =)

SINGLE OR MULTIPLE BOARDS, COMMISSIONS,
COUNCIL, PANELS, OR OTHER BODIES

\.

N
J

RECEIVES NO MORE THAN $5,000 PER YEAR

.

N
J

LIMIT INCLUDES ALL PARTICIPATING EMPLOYERS COMBINED
(COMPENSATION, REMUNERATION, STIPEND, OR OTHER BENEFIT)

®URS

Utah Retirement Systems

f
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Utah Code 49-11-1206

Notice of Post-Retired Re-employment

PARTICIPATING EMPLOYER SHALL
IMMEDIATELY NOTIFY THE OFFICE IF:

RE-EMPLOYS A RETIREE

RE-EMPLOYMENT IS SUBJECT TO 49-11-1204 OR 49-11-1205

7
J A\

ANY ELECTION BY THE RETIREE

THE POSITION IS ELECTED PART-TIME
\ ) @URS

Utah Retirement Systems




Utah Code 49-11-1207

Post-Retirement Re-employment Violations

( )

NOTICE OF RE-EMPLOYMENT OF A RETIREE IN VIOLATION

(
\

IMMEDIATELY CANCEL THE RETIREE'S ALLOWANCE

N
J/

RECOVER ANY OVERPAYMENT RESULTING IN VIOLATION

N\
VAN

IF RETIREE OR EMPLOYER FAIL TO REPORT VIOLATION,
RETIREE, EMPLOYER, OR BOTH ARE LIABLE TO THE OFFICE

L FOR THE AMOUNT OF OVERPAYMENT p URS

Utah Retirement Systems




Utah Code 49-11-1301

Phased Retirement
.
4 A RETIREE WORKS 20 HOURS/WEEK
(1,040 HOURS/YEAR) y
PUBLIC EMPLOYEES ~N
[ RECEIVES 50% OF RETIREMENT ALLOWANCE
J
4 N\ ( RETIREE WORKS THREE-QUARTER-TIME N
L (1,560 HOURS/YEAR) y
PUBLIC SAFETY/FIREFIGHTER P N
RECEIVES 25% OF RETIREMENT ALLOWANCE
\_ 1 | J

®&URS
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Utah Code 49-11-1301

Phased Retirement

( )

EMPLOYER MUST HAVE A WRITTEN POLICY IN PLACE

EMPLOYEE MUST BE ELIGIBLE TO RETIRE

MUST BE FULL TIME WITH EMPLOYER FOR FOUR YEARS PRIOR

MUST APPLY WITH RETIREMENT APPLICATION

\, y
( )
MUST BEGIN PHASED RETIREMENT WITHIN 120 DAYS OF RETIRING
\, v
( Y

(=)
MAY NOT BE WORKING FOR MULTIPLE PARTICIPATING EMPLOYERS URS
v

Utah Retirement Systems




Utah Code 49-11-1401

Forfeiture of Retirement Benefits

4 )

IF EMPLOYEE CONVICTED OF EMPLOYMENT
RELATED FELONY OFFENSE

\ V.
( )
EMPLOYEE SHALL FORFEIT RETIREMENT BENEFITS
\ V.
( )

FORFEITURE BEGINS THE DAY OF WHICH THE
EMPLOYMENT RELATED OFFENSE OCCURRED

CONTINUES UNTIL TERMINATED FROM POSITION
FOR WHICH OFFENSE OCCURRED

EMPLOYER REQUIREMENT: NOTIFY URS IMMEDIATELY

\ J@URS

Utah Retirement Systems
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Utah Code 49-12-102 & 49-13-102
Qualitying Benefits Normally Provided

-

EMPLOYER-PAID LEAVE BENEFIT
OF ANY KIND

N

-

4 EMPLOYER CONTRIBUTIONS
TOAN H.S.A,, AN H.R.A., AHEALTH
REIMBURSEMENT ARRANGEMENT,

OR A MEDICAL EXPENSE
REIMUBURSEMENT PLAN

-

/
~N

[

\

INSURANCE COVERAGE OF ANY KIND
IF EMPLOYER PAYS SOME OR ALL
OF PREMIUM FOR COVERAGE

-
-

A

N\

A
\
RETIREMENT BENEFIT OF ANY KIND

IF EMPLOYER PAYS SOME OR
ALL OF THE COST OF THE BENEFIT

y
®URS
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Utah Code 49-12-102 & 49-13-102

Compensation
( N
ALL EARNINGS ARE REPORTABLE
\L J
( )
BONUSES, OVERTIME, EXTRA WORK FOR EXTRA PAY
\, J/
( )
ALLOWANCES, EXPENSES, REIMBURSEMENTS
NOT REPORTABLE
\, J
( )
TERMINATION PAYOUTS NEVER REPORTABLE
\\ v

®URS

Utah Retirement Systems




Utah Code 49-12-102 & 49-13-102
System Membership Eligibility

EMPLOYMENT NORMALLY REQUIRES AN AVERAGE OF
20 HOURS OR MORE PER WEEK

RECEIVES BENEFITS NORMALLY PROVIDED
BY THE PARTICIPATING EMPLOYER

\ v
4 )
ELIGIBILITY REQUIRES BOTH HOURS AND BENEFITS
\, V.
r )

TOTALAMOUNT CONTRIBUTED BY EMPLOYER VESTS TO THE
MEMBER UPON ACCRUING FOUR YEARS OF SERVICE CREDIT

®&URS

Utah Retirement Systems




Utah Code 49-12-102
Eligibility of Elected and Appointive Officials

s N
TIER | MINIUMUM EARNINGS REQUIREMENT
\_ J
s N
ELIGIBILITY BASED ON CURRENT REQUIREMENT: $1,240.00 (2/1/2023)
L EARNINGS ONLY AN p
(
TIER II FULL-TIME = ELIGIBLE 3
L Y
EMPLOYER MUST DESIGNATE a PART-TIME = INELIGIBLE 3
. ELIGIBILITY IN WRITING ) U Y,

®&URS
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Utah Code 49-12-102 & 49-13-102

Classified School Employees Eligibility
4 B

( ™\
AVERAGE OF 20+ HOURS PER WEEK
HIRED BEFORE - /
JULY 1, 2013 | NO QUALIFYING BENEFIT REQUIRED
J
“GRANDFATHER CLAUSE” P N
PRIOR SERVICE WITH NO 120-DAY BREAK
\_ J y
4 N
HIRED ON OR AETER [ AVERAGE OF 20+ HOURS PER WEEK j
JULY 1, 2013
( NORMAL BENEFIT PROVIDED j
\_ Y,

®&URS
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Utah Code 49-12-202 & 49-13-202

Participation of Employers -- Limitations
4 N )

AN EMPLOYER IS A IN ADDITION TO THIS SYSTEM,
PARTICIPATING EMPLOYER AN EMPLOYER MAY PROVIDE
AND MAY NOT WITHDRAW AN ADDITIONAL PUBLIC/PRIVATE

FROM THE SYSTEM RETIREMENT FOR EMPLOYEES

o AN v

®&URS
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Utah Code 49-12-203 & 49-13-203

Exclusion From Membership in System
4 N N N

EMPLOYEE EMPLOYER IS IN

WHOSE EMPLOYMENT EMPLOYEE HIGHER EDUCATION
IS TEMPORARY SERVING AS AN AND PARTICIPATES IN
BASED ON EXCHANGE EMPLOYEE

TYPE OF WORK ALTERNATE PLAN

\- J AN /

®&URS
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Utah Code 49-12-203 & 49-13-203

Exclusions From Membership in System
4 )

EMPLOYER SHALL ( ELECTED OFFICIALS ]
PREPARE AND MAINTAIN > <
ALIST DESIGNATING APPOINTIVE OFFICERS
POSITIONS ELIGIBLE > <
FOR EXEMPTION AT-WILL EMPLOYEES
\_ J \ J
4 )

TIER | = EXEMPT FROM SYSTEM

EXEMPTION DIFFERENCES

TIER I = EXEMPT FROM VESTING PERIOD ]

®&URS

Utah Retirement Systems
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Utah Code 49-12-204 & 49-13-204

Higher Education — Elections Between Plans

4 )

EMPLOYEES OF HIGHER EDUCATION INSTITUTIONS GET
A ONE-TIME ELECTION TO CONTINUE PARTICIPATION IN
THE URS SYSTEM IF THE EMPLOYEE HAS SERVICE CREDITS
BEFORE DATE OF EMPLOYMENT WITH HIGHER ED AGENCY

HIGHER EDUCATION INSTITUTION REQUIREMENTS:

( N

MUST GIVE EMPLOYEES WITH PRIOR SERVICE
THE OPTION TO RETURN TO URS

MUST CERTIFY ALL EMPLOYEES WITH URS

€ ¢
ALL POST-RETIREMENT LAWS APPLY TO ALTERNATE PLAN URS

Utah Retirement Systems




Utah Code 49-12-301

Contributions — Contributory Retirement Systems

-

\
A PARTICIPATING EMPLOYER MAY
ELECT TO PAY ALL OR PART OF THE
REQUIRED MEMBER CONTRIBUTIONS,
IN ADDITION TO THE REQUIRED
EMPLOYER CONTRIBUTIONS

-~

o /

e

ANY AMOUNT CONTRIBUTED BY A
PARTICIPATING EMPLOYER SHALL
VEST TO THE MEMBER'’S BENEFIT
AS THOUGH THE MEMBER HAD
MADE THE CONTRIBUTIONS

~

/

®&URS
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Utah Code 49-13-301

Contributions — Noncontributory Retirement Systems
4 )

PARTICIPATING EMPLOYERS PAY THE CERTIFIED
CONTRIBUTION RATES TO THE OFFICE
TO MAINTAIN THIS SYSTEM ON A
FINANCIALLY AND ACTUARIALLY SOUND BASIS

o /

®&URS
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Utah Code 49-12-401 & 49-13-401
Eligibility for an Allowance

g BEFORE RETIREMENT DATE, MEMBER CEASES ACTUAL h
WORK FOR EVERY PARTICIPATING EMPLOYER
AND PROVIDES EVIDENCE OF THE TERMINATION

(
\.

MEMBER HAS SUBMITTED A RETIREMENT APPLICATION FORM
THAT STATES THE PROPOSED RETIREMENT DATE

\
J/

THE MEMBER'S RETIREMENT DATE:

\_ J
( suaeetHE  )[  sHaLBEoN  )[ MAYNOTBEMORE |
18T OR 16T OR AFTER THE THAN 90 DAYS
DAY OF THE MONTH TERMINATION DATE BEFORE OR AFTER
APPLICATION ¢.¢| IRS
_ J AN y

Utah Retirement Systems




Utah Code 49-12-401 & 49-13-401

Not Required to Cease Service for Allowance

4 D
A MEMBER WHO IS A PART-TIME ELECTED OFFICIAL
\. y
( )
A MEMBER WHO IS A PART-TIME APPOINTED BOARD MEMBER
\ A
4 )

A MEMBER WHO IS ALSO AN AFFILIATED
EMERGENCY SERVICE WORKER

A MEMBER WHO IS A PART-TIME APPOINTED OR ELECTED
BOARD MEMBER FOR ADIFFERENT AGENCY

®&URS

Utah Retirement Systems




Utah Code 49-12-402 & 49-13-402

Service Retirement Plans (Tier I)

4 )

CEASE ACTUAL WORK WITH ALL PARTICIPATING EMPLOYERS
PRIOR TO RETIREMENT DATE

s S
PROVIDE EVIDENCE OF TERMINATION

\ A

( )

SUBMIT APPLICATION WITH PROPOSED RETIREMENT DATE
(MUST BE 1ST OR 16TH OF MONTH)

ACCRUE 30 YEARS OF SERVICE
(REDUCTIONS MADE FOR LESS THAN AGE 65)

~
J

RETIREMENT ON OR AFTER TERMINATION DATE MAY NOT BE MORE
THAN 90 DAYS BEFORE OR AFTER APPLICATION IS SUBMITTED ) URS

Utah Retirement Systems




Utah Code 49-12-406 & 49-13-406

Exceptions — Justice Court Judges (Tier I)

[ A JUSTICE COURT JUDGE WHO HAS: ]
| SERVICE WITH MORE THAN ONE PARTICIPATING EMPLOYER |
: PART-TIME WITH EACH EMPLOYER ]
| WHEN AGGREGATED, AMOUNTS TO FULL-TIME SERVICE |
[ VERIFICATION OF ELIGIBILITY J
ADMINSTRATIVE OFFICE OF THE COURTS

®&URS

Utah Retirement Systems




B utah Code Title 49 x +

&< - C (O & https//leutah.gov/xcode/Title49/49.html

"/ "W UTAH STATE Legislators Bills Code Committees Audits Budget RedseLarchI
il LEGISLATURE and Lega

Index Utah Code
Title 49 Utah State Retirement and Insurance Benefit Act

Chapter 11 Utah State Retirement Systems Administration
Chapter 12 Public Employees’ Contributory Retirement Act
Chapter 13 Public Emplu‘,rees NGHCGH’[rIbUtDW Retirement Act

Chapter 16 Firefighters' Retirement Act
Chapter 17 Judges' Contributory Retirement Act
Chapter 18 Judges' Noncontributory Retirement Act

Chapter 19 Utah Governors' and Legislators’ Retirement Act

Chapter 20 Public Employees’ Benefit and Insurance Program Act

Chapter 21 Public Employees’ Long-Term Disability Act

Chapter 22 New Public Employees' Tier II Contributory Retirement Act

Chapter 23 New Public Safety and Firefighter Tier II Contributory Retirement Act




Utah Code 49-14-102 & 49-15-102

Compensation — Public Safety

s

COMPENSATION MEANS THE TOTALAMOUNT OF PAYMENTS
INCLUDED IN GROSS INCOME AS BASE INCOME FOR THE
L REGULARLY-SCHEDULED WORK PERIOD )

PARTICIPATING EMPLOYER SHALL ESTABLISH THE
REGULARLY-SCHEDULED WORK PERIOD

DECLARATION OF REGULARLY-SCHEDULED WORK PERIOD
MUST BE SUBMITTED TO URS

COMPENSATION INCLUDES PERFORMANCE-BASED BONUSES
AND COST-OF-LIVING ADJUSTMENTS

L~

®URS

Utah Retirement Systems




Utah Code 49-14-102 & 49-15-102
Public Safety Service

4 N

EMPLOYMENT NORMALLY REQUIRING
AN AVERAGE OF 2,080 HOURS
OF REGULARLY SCHEDULED
EMPLOYMENT PER YEAR

o /

LAW ENFORCEMENT OFFICER

CORRECTIONAL OFFICER

SPECIAL FUNCTION OFFICER

DISPATCHER

S\

S YO YO YA

L~

®URS
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Utah Code 49-14-201 & 49-15-201
System Membership - Dual Purpose Employees

\

PARTICIPATING EMPLOYER HAVING PUBLIC SAFETY SERVICE AND

FIREFIGHTER SERVICE EMPLOYEES THAT REQUIRE CROSS-TRAINING
\. y
4 ~

SHALL ENROLL DUAL PURPOSE EMPLOYEES IN SYSTEM
WHICH THE GREATEST AMOUNT OF TIME IS WORKED

N
J/

TO TRANSFER SERVICE, PARTICIPATING EMPLOYER
MUST RECEIVE WRITTEN NOTICE FROM URS

N\
VAN

URS MAY REQUEST DOCUMENTATION TO VERIFY
THE APPROPRIATENESS OF THE TRANSFER

®URS

Utah Retirement Systems
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Utah Code 49-14-201 & 49-15-201
Public Safety Job Descriptions

f p
PARTICIPATING EMPLOYER SHALL ANNUALLY SUBMIT SCHEDULE
INDICATING POSITIONS COVERED IN PUBLIC SAFETY SYSTEM

(
\

ANNUAL CERTIFICATION COMPLETED
ELECTRONICALLY ON THE EMPLOYER PORTAL

N
J/

PARTICIPATING EMPLOYERS REQUIRED TO SUBMIT
DOCUMENTATION FOR EACH POSITION

N\
VAN

JOB DESCRIPTIONS MUST BE SUBMITTED ELECTRONICALLY

\ J ®URS

Utah Retirement Systems




Utah Code 49-14-201 & 49-15-201

Public Safety Service
4 )

A PUBLIC SAFETY
SERVICE EMPLOYEE WHO IS
TRANSFERRED OR PROMOTED
TO AN ADMINISTRATIVE
POSITION WITH DUTIES THAT
CONSIST PRIMARILY OF
MANAGEMENT OR SUPERVISION
OF PUBLIC SAFETY EMPLOYEES,
SHALL CONTINUE TO EARN
PUBLIC SAFETY SERVICE

- /

!

P.O.S.T. CERTIFICATION REQUIRED j

!

MUST BE SUBMITTED TO URS
IMMEDIATELY UPON RECEIPT

-

®URS

Utah Retirement Systems
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Utah Code 49-14-201 & 49-15-201
Eligibility Requirements

EMPLOYEE'S LIFE OR PERSONAL SAFETY AT RISK
. (EXCEPT FOR DISPATCHERS) )
( )
DUTIES CONSIST PRIMARILY OF ACTIVELY PREVENTING OR DETECTING
CRIME AND ENFORCING CRIMINAL STATUTES OR ORDINANCES

7
\

4 )
DUTIES CONSIST PRIMARILY OF PROVIDING COMMUNITY PROTECTION

\. V.

r )

RESPONDS TO THREATS TO PUBLIC SAFETY AND MAKES EMERGENCY
DECISIONS AFFECTING THE LIVES AND HEALTH OF OTHERS

P.O.S.T. CERTIFICATION REQUIRED FOR

3 ALL PUBLIC SAFETY EMPLOYEES ) URS

Utah Retirement Systems




Utah Code 49-14-201 & 49-15-201
Public Safety -- Dispatcher

4 )

DISPATCHERS CAN BE COVERED BY PUBLIC SAFETY IF EMPLOYED
BY EMPLOYER WHO ELECTS COVERAGE UNDER THIS SYSTEM

EMPLOYER ELECTION MUST BE DOCUMENTED IN A
RESOLUTION ADOPTED BY THE GOVERNING BODY

\ J
4 )
ELECTION IS IRREVOCABLE
\. V.
4 D
DISPATCHERS MUST:
\ 4
BE HAVE AN BE DISPATCH
FULL-TIME APPROVED P.O.S.T. CERTIFIED =)
®&URS

JOB DESCRIPTION

Utah Retirement Systems




Utah Code 49-14-401 & 49-15-401

Eligibility for Service Retirement (Tier I)

4 )

CEASE ACTUAL WORK WITH ALL PARTICIPATING EMPLOYERS
PRIOR TO RETIREMENT DATE

s S
PROVIDE EVIDENCE OF TERMINATION

\ A

( )

SUBMIT APPLICATION WITH PROPOSED RETIREMENT DATE
(MUST BE 1ST OR 16TH OF MONTH)

ACCRUE 20 YEARS OF SERVICE
(10 YEARS AT AGE 60 OR 4 YEARS AT AGE 65)

~
J

RETIREMENT ON OR AFTER TERMINATION DATE MAY NOT BE MORE
THAN 90 DAYS BEFORE OR AFTER APPLICATION IS SUBMITTED ) URS

Utah Retirement Systems




B utah Code Title 49 x 4+

< C (O @& httpsy//le.utah.gov/xcode/Title49/49.html

UTAH STATE Legislators Bills Code Committees Audits Budget Research

weaN) | EGISLATURE and Legal

Index Utah Code
Title 49 Utah State Retirement and Insurance Benefit Act

Chapter 11 Utah State Retirement Systems Administration

Chapter 12 Public Employees’ Contributory Retirement Act

Chapter 13 Public Employees’ Noncontributory Retirement Act
Chapter 14 Public Safety Contributory Retirement Act

Chapter 15 Public Safety Noncontributory Retirement Act

Chapter 17 Judges' Contributory Retirement Act

Chapter 18 Judges' Noncontributory Retirement Act

Chapter 19 Utah Governors' and Legislators’ Retirement Act

Chapter 20 Public Employees’ Benefit and Insurance Program Act
Chapter 21 Public Employees’ Long-Term Disability Act

Chapter 22 New Public Employees' Tier II Contributory Retirement Act
Chapter 23 New Public Safety and Firefighter Tier II Contributory Retirement Act




Utah Code 49-16-102

Compensation -- Firefighters

s

COMPENSATION MEANS THE TOTALAMOUNT OF PAYMENTS
INCLUDED IN GROSS INCOME AS BASE INCOME FOR THE
L REGULARLY-SCHEDULED WORK PERIOD )

PARTICIPATING EMPLOYER SHALL ESTABLISH THE
REGULARLY-SCHEDULED WORK PERIOD

DECLARATION OF REGULARLY-SCHEDULED WORK PERIOD
MUST BE SUBMITTED TO URS

COMPENSATION INCLUDES PERFORMANCE-BASED BONUSES
AND COST-OF-LIVING ADJUSTMENTS

Lo

®URS

Utah Retirement Systems




Utah Code 49-16-102

Firefighter Service

4 )

EMPLOYMENT NORMALLY REQUIRING AVERAGE OF 2,080 HOURS
REGULARLY SCHEDULED EMPLOYMENT PER YEAR

\ V.
a4 )
EMPLOYEE TRAINED IN FIREFIGHTER TECHNIQUES
\ S
( )

ASSIGNED TO APOSITION OF HAZARDOUS DUTY WITH
A REGULARLY CONSTITUTED FIRE DEPARTMENT

DOES NOT INCLUDE SECRETARIAL STAFF
OR OTHER SIMILAR EMPLOYEES

FIRE DEPARTMENT EMPLOYS A FULL-TIME FIRE CHIEF
. WHO PERFORMS FIREFIGHTER SERVICE ) URS

Utah Retirement Systems




Utah Code 49-16-401

Eligibility for Service Retirement

4 )

CEASE ACTUAL WORK WITH ALL PARTICIPATING EMPLOYERS
PRIOR TO RETIREMENT DATE

PROVIDE EVIDENCE OF TERMINATION

r
\.

SUBMIT APPLICATION WITH PROPOSED RETIREMENT DATE
(MUST BE 1ST OR 16TH OF MONTH)

ACCRUE 20 YEARS OF SERVICE
(10 YEARS AT AGE 60 OR 4 YEARS AT AGE 65)

~
J

RETIREMENT ON OR AFTER TERMINATION DATE MAY NOT BE MORE
THAN 90 DAYS BEFORE OR AFTER APPLICATION IS SUBMITTED ) URS

Utah Retirement Systems




Utah Code 49-16-701

Volunteer Firefighters
4 )

AVOLUNTEER FIREFIGHTER IS
ONLY ELIGIBLE FOR LINE-OF-DUTY
DEATH AND LINE-OF-DUTY DISABILITY
BENEFITS PROVIDED FOR
FIREFIGHTERS ENROLLED IN
DIVISION A

4 )

EACH VOLUNTEER FIRE
DEPARTMENT SHALL MAINTAIN
A CURRENT ROLL OF ALL VOLUNTEER
FIREFIGHTERS WHICH MEET
REQUIREMENTS TO DETERMINE
ELIGIBILITY FOR THIS BENEFIT

o /

o /

Lo

®URS
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Additional Chapters

For Your Reference

Chapter 17 Judges’ Contributory Retirement Act

Chapter 18 Judges’ Noncontributory Retirement Act

Chapter 19 Utah Governors’ and Legislators’ Retirement Act
Chapter 20 Public Employees’ Benefit and Insurance Program Act

Chapter 21 Public Employees’ Long-Term Disability Act

®&URS

Utah Retirement Systems




B utah Code Title 49 x 4+

< C (O @& httpsy//le.utah.gov/xcode/Title49/49.html

UTAH STATE Legislators Bills Code Committees Audits Budget Research

weaN) | EGISLATURE and Legal

Index Utah Code
Title 49 Utah State Retirement and Insurance Benefit Act

Chapter 11 Utah State Retirement Systems Administration
Chapter 12 Public Employees’ Contributory Retirement Act
Chapter 13 Public Employees’ Noncontributory Retirement Act
Chapter 14 Public Safety Contributory Retirement Act

Chapter 15 Public Safety Noncontributory Retirement Act
Chapter 16 Firefighters' Retirement Act

Chapter 17 Judges' Contributory Retirement Act

Chapter 18 Judges' Noncontributory Retirement Act

Chapter 19 Utah Governors' and Legislators’ Retirement Act
Chapter 20 Public Employees’ Benefit and Insurance Program Act
Chapter 21 Public Employees’ Long-Term Disability Act

Chapter 22 New Public Employees’ Tier II Contributory Retirement Act

Chapter 23 New Public Safety and Firefighter Tier II Contributory Retirement Act




Utah Code 49-22-201

Tier II Contributory Retirement Act — Public Employees

4 )

ENTERING FULL-TIME EMPLOYMENT ON OR AFTER JULY 1, 2011,
WITH NO PRIOR SERVICE ACCRUED

TIER Il EMPLOYEE MUST MAKE AN ELECTION TO PARTICIPATE IN
THE SYSTEM CREATED UNDER THIS CHAPER

TIER Il HYBRID RETIREMENT SYSTEM OR
TIER Il DEFINED CONTRIBUTION PLAN

ELECTRONICALLY SUBMIT NOTIFICATION OF ELECTION
WITHIN ONE YEAR FROM DATE OF HIRE

TIER Il ELECTION IS IRREVOCABLE

®URS

Utah Retirement Systems
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Utah Code 49-22-205

Tier II Exemptions From Participation in System

4 )
ELECTED
OFFICIAL

- )

4 )

APPOINTIVE
OFFICER
. .

4 =\
ONLY ALLOWED PATRICIPATION IN DC PLAN

\ J
4 ™
¢ IMMEDIATELY VESTED IN BENEFIT

J
4 ™
¢ BENEFIT IS NONFORFEITABLE

J

( CAN EXEMPT (FROM VESTING) UP TO ANNIVERSARY DATE ]

[MUST IMMEDIATELY NOTIFY APPOINTEE OF EXEMPTION OPTION]

®&URS

Utah Retirement Systems




Utah Code 49-22-301

Tier II Hybrid Retirement System — Public Employees

4 )

EMPLOYERS PAY UP TO 10% OF COMPENSATION
TOWARDS CERTIFIED CONTRIBUTION RATE

MEMBER PAYS PORTION THAT EXCEEDS THE PERCENT
PAID BY THE EMPLOYER

EMPLOYER REQUIRED TO PAY CORRESPONDING
TIER | AMORTIZATION RATE (BUILT-IN)

EMPLOYER MAY NOT ELECT TO PAY ALL OR PART OF
THE REQUIRED MEMBER CONTRIBUTIONS

L~

®URS

Utah Retirement Systems




Utah Code 49-22-304

Defined Benefit Eligibility for an Allowance —

Public Employees
MEMBER HAS ACCRUED AT LEAST 35 YEARS OF SERVICE CREDIT

MEMBER HAS ACCRUED 20 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 60 YEARS

MEMBER HAS ACCRUED 10 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 62 YEARS

MEMBER HAS ACCRUED 4 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 65 YEARS

-

®URS

Utah Retirement Systems
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Utah Code 49-22-401

Tier II Defined Contribution Plan — Public Employees

4 )

EMPLOYERS PAY UP TO 10% OF COMPENSATION
TOWARDS CERTIFIED CONTRIBUTION RATE

EMPLOYER REQUIRED TO PAY CORRESPONDING
TIER | AMORTIZATION RATE (BUILT-IN)

MEMBER MAY MAKE VOLUNTARY DEFERRALS
TO THE QUALIFIED 401(K)

NO LOANS OR HARDSHIP WITHDRAWALS AVAILABLE FROM
CONTRIBUTIONS MADE BY PARTICIPATING EMPLOYER

-

®URS

Utah Retirement Systems
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B utah Code Title 49 X
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Chapter 22

Utah State Retirement Systems Administration

Public Employees' Contributory Retirement Act
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Public Safety Noncontributory Retirement Act
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Utah Governors' and Legislators' Retirement Act
Public Employees' Benefit and Insurance Program Act

Public Employees' Long-Term Disability Act

New Public Emplcwees Tier II Contributory Retirement Act




Utah Code 49-23-301

Tier II Hybrid Retirement System —
Public Safety & Firefighters

EMPLOYERS PAY UP TO 14% OF COMPENSATION
TOWARDS CERTIFIED CONTRIBUTION RATE

MEMBER PAYS PORTION THAT EXCEEDS THE
PERCENT OF COMPENSATION PAID BY THE EMPLOYER

EMPLOYER MAY ELECT TO PAY ALL OR PART OF
THE REQUIRED MEMBER CONTRIBUTIONS

EMPLOYER REQUIRED TO PAY CORRESPONDING
TIER | AMORTIZATION RATE (BUILT IN)

-

®URS

Utah Retirement Systems
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Utah Code 49-23-303

Tier II Defined Benefit Eligibility for an Allowance —
Public Safety & Firefighters

MEMBER HAS ACCRUED AT LEAST 25 YEARS OF SERVICE CREDIT

\, S
4 )

MEMBER HAS ACCRUED 20 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 60 YEARS

\
J

MEMBER HAS ACCRUED 10 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 62 YEARS

MEMBER HAS ACCRUED 4 YEARS OF SERVICE CREDIT
AND HAS ATTAINED AN AGE OF 65 YEARS

®&URS

Utah Retirement Systems




Utah Code 49-23-401

Tier II Defined Contribution Plan —
Public Safety & Firefighters

PARTICIPATING EMPLOYER PAYS UP TO 14% OF COMPENSATION
TOWARD THE CERTIFIED CONTRIBUTION RATE

Y4
AN

EMPLOYER ELECTING TO PAY ALL OR PART OF REQUIRED MEMBER
CONTRIBUTIONS, MUST MAKE ADDITIONAL NONELECTIVE
CONTRIBUTION AT SAME PERCENTAGE RATE (Hybrid & DC)

\.
r

J A

EMPLOYER PAYS CORRESPONDING TIER | SYSTEM AMORTIZATION
RATE

-

®URS

Utah Retirement Systems
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Utah Code 49-23-401

Tier II Defined Contribution Plan —
Public Safety & Firefighters

MEMBER MAY MAKE VOLUNTARY DEFERRALS
TO THE QUALIFIED 401(K)

TOTALAMOUNT CONTRIBUTED BY EMPLOYER
VESTS TO MEMBER UPON ACCRUING FOUR YEARS SERVICE CREDIT

TOTALAMOUNT CONTRIBUTED BY MEMBER
VESTS IMMEDIATELY AND IS NONFORTEITABLE

NO LOANS OR HARDSHIP DISTRIBUTIONS AVAILABLE FROM
CONTRIBUTIONS MADE BY A PARTICIPATING EMPLOYER

-

®URS

Utah Retirement Systems
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RS Board Resolutions
®URS a Loain

Utah Retirement Systems

L€~

Home Publications Videos Calculators Education ~ Daily Unit Values

E M P L OYE RS Our online tools are your key to establishing and managing your employees' retirement benefits.

Employer Guide THE URS NEWSROOM: FOR POLICYMAKERS, MEDIA, AND THE PUBLIC

Contribution Rates
)
U~

Tier 2 Employment

®

) For Media
Utah Retirement Systems

Knowledge Corner

N

Board Resolutions
AUREUS

Feedback/Contact Search... Clear Search

Use quotation marks to search a phrase e g. "Life Insurance”
Board Resolutions If multiple words are entered without the quotation marks, all of the records matching each term are returmned

Reporting a Death Group by: Year

Employer Training/Events
Adjudicative Hearing Procedures [Count : 2]
Change in Structure [ Count: 2] ‘Q&j

Utah Retirement Systems

Lo

Compensation




THE URS NEWSROOM: FOR POLICYMAKERS, MEDIA, AND THE PUBLIC

@URS

Utah Retirement Systems

Board Resolutions

Public Safety Clear Search

Use ation marks to search a phrase e g. "Life Insurance”.
If multiple words are entered without the quotation marks, all of the records matching each term are returned

Group by: Je=1Te(e14Y Year

Firefighter and Public Safety Retirement Systems
™ Resolution: RESOLUTION 2020-03- Tier 2 Public Safety and Firefighter Member Contributions During the First Year of Employment

™! Resolution: 2019-01 Public Safety Retirement Eligibility

T Resolution: 2008-06 Application of Tax Exclusion Factor to Disability Benefits at the Time of Conversion

T Resolution: 2003-03 Compensation and Rate of Pay for Members of the FF and PS Retirement System



Resolution 2019-01

Public Safety Retirement Eligibility
4 N N[O )

PERSON FAILING TO
PROVIDE EVIDENCE

OF PEACE OFFICER THERE IS NO AUTHORITY PI\EA,k\ng-Er (S)gEIhéII-ErR
CERTIFICATION WITHIN TO EXTEND THE CERTIFICATIONS
ONE YEAR OF HIRE ONE-YEAR DEADLINE IMMEDIATELY

WILL BE REMOVED FOR COMPLETION

FROM PUBLIC SAFETY UPON RECEIPT

RETIREMENT SYSTEM

- A\ AN /
@®URS

Utah Retirement Systems




Resolution 2019-05

Volunteers

4 )

A PERSON WHO PROVIDES SERVICES TO AN EMPLOYER
WITHOUT A FEE-FOR-SERVICE RELATIONSHIP

N [
A\

COMPENSATION INCLUDES CASH, WAGES, STIPENDS,
VOUCHERS, GIFT CARDS, OR OTHER CASH EQUIVALENTS

~N
J/

COMPENSATION DOES NOT INCLUDE MINIMAL VALUE
GOODS OR SERVICES PROVIDED TO AVOLUNTEER

MINIMAL VALUE GOODS OR SERVICES TOTAL COMBINED VALUE
MUST BE LESS THAN $250 A CALENDAR YEAR

Lo

®URS

Utah Retirement Systems




Resolution 2019-05

Termination of Employment and Reemployment

4 )
BONA EIDE TERMINATION — PERMANENT EX’TINGUISHMENT OF ALL
OF EMPLOYOMENT o OF A PERSON'S FEE-FOR-SERVICE
RELATIONSHIP OF ANY KIND
. A - A
4 ) 4 )
— ANY EXPECTATION OR PROMISE
FEE-FOR-SERVICE RELATIONSHIP o OF COMPENSATION FOR ANY
SERVICE OF ANY KIND
- A - A
4 ) 4 )
— THE RESUMPTION OF A FEE-FOR-SERVICE
REEMPLOYMENT — RELATIONSHIP OF ANY KIND AFTER
L ) A BONA FIDE TERMINATION

Lo

®URS
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Secure 2.0 Act of 2022

Senate Finance Committee Updates

4 )

AUTOMATICALLY ENROLLS NEW ELIGIBLE EMPLOYEES IN
401(K) OR 403(B) PLANS STARTING IN 2025

N [
A\

MINIMUM PRETAX CONTRIBUTION EQUAL TO 3% OF THEIR WAGES

~N
J/

EMPLOYEE CONTRIBUTIONS INCREASE BY 1% EACH YEAR UNTIL
THEY REACH 10% (NOT TO EXCEED 15% OF THEIR EARNINGS)

-
\

INCREASE IN AGE FOR REQUIRED BEGINNING DATE
FOR MANDATORY DISTRIBUTIONS

-

®URS

Utah Retirement Systems
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Secure 2.0 Act of 2022

Senate Finance Committee Updates

.
/ \ SMALL IMMEDIATE FINANCIAL INCENTIVE TO CONTRIBUTE J
\
(~ )
INCENTIVE NOT PAID FOR WITH PLAN ASSETS (E.G. GIFT CARDS)
\_ J
4 =)
BILL PROVIDES EXEMPTION FROM CONTINGENT BENEFIT RULE )
\
( =)
SECTION RELIEF FROM |.R.S. AND E.R.l.S.A. PROHIBITED TRANSACTION RULES
113 ; .
EFFECTIVE IMMEDIATELY )
\

Lo

®URS
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Secure 2.0 Act of 2022

Senate Finance Committee Updates

( =)

/ \ PART-TIME WORKER 401(K) COVERAGE EXPANDED J
\.

(~ )

EMPLOYEE WITH 1 YEAR OF SERVICE WITH 1,000 HOURS

\_ J

(~ =)

BILL EMPLOYEE WITH 2 YEARS OF SERVICE WITH 500 HOURS )
\_

(~ =)

SECTION DOES NOT PERTAIN TO EMPLOYER CONTRIBUTIONS

125 . /

EFFECTIVE PLAN YEARS BEGINNING AFTER 2024 )
\_

Lo

®URS
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Secure 2.0 Act of 2022

Senate Finance Committee Updates

4 AYa 457(b) ENROLLMENT 3
q J
s N
DEFERRED COMPENSATION ELECTION MAY BE MADE

BILL L ANY TIME PRIOR TO AVAILABILITY )
SECTION | ( EFFECTIVE IMMEDIATELY 3
306 \ Y,

\_ Y,

®&URS

Utah Retirement Systems




House Bill 183 (2023)

Firefighter Retirement Revisions

4 )

ALLOWS EMERGENCY MEDICAL SERVICE PERSONNEL
TO PARTICIPATE IN FIREFIGHTER' SYSTEM

N
AL

EMPLOYER MUST MAKE ELECTION
ELECTION IS IRREVOCABLE

~N
J/

EMPLOYER MUST HAVE A FULL-TIME FIRE CHIEF
OR EMERGENCY SERVICES COORDINATOR

-
\

EMPLOYEES MUST BE FULL-TIME
EFFECTIVE JULY 1, 2023

L~

®URS
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Retirement Planning
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Employee Tier 2 Choice

Employees on average

» 78.4% Hybrid
» Public Safety and Firefighters slightly higher
» 21.6% DC only (401K)

*Based on URS Quarterly Tier 2 Statistics as of Jan. 1, 2023, and Savings Plans

Department Tier 2 Statistic report ending Dec. 31, 2022
®&URS
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Employee Tier 2 Choice
Other considerations

» Active choice or default?

» 45% of employees (almost 50,000) have no beneficiaries on Tier 2
options

» Valuable death benefits

» 10% retirement contribution — better than a match

» Recognize Tier 2 creates a: oo (g

2 penelS

» Competitive edge for you, the employer (hiring)

» Reason for an employee to stay on (retention) e




Recommended URS Onboarding
Process

» Easily guide new employees:
» Enrolling in and understanding their URS benefits
» 1 year to make irrevocable election

» Empower new employee to make Tier 2 choice

» Tier 2 New Hire Check List

®&URS
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Tier 2 New Hire Checklist

Q{ Create account @ .o

Create New Account

» Urs.org

SSN (last 4 digits)

|

» New members section |
m U RS Date of Birth (mm/dd/yyyy)
» Online Enroliment y R et
QCCOUNT OCCESS

« \Where do | find my Member Number? 7.
« | forgot my Member Number

» Watch video on
how to create a
myURS account

| elect to have my account confirmations emailed to me.
| elect to receive my URS defined benefit (pension) and defined
contribution (savings) statements online only.

O |elect to receive my URS tax documents online only.
O Ielect to receive my URS tax documents by mail.

'S




Tier 2 New Hire Checklist

Logged in as: URS Member Member # W12345678

Q{ Create account

» Manage Profile

» Look for the orange
lettering

» Easily update personal
contact information

MyURS

ount access

Profile

My Profile Overview

Change Address and Phone Number

Security

Beneficiaries

Paperless Preferences

Change Marital Status and Spouse Info.

Overview

MESSAGE CENTER o MANAGE PROFILE O LOGOUT °

Savings Pension

Education

e You are receiving your tax documents and/or statements by mail. Switch to paperless

My Profile Overview

Current Profile

Name

Marital Status

Spouse Information

Mailing Address

Phone Number

Email Address

Confirmation Delivery Choice

URS Statements Choice

URS Member
URS Member Spouse
URS Member Spouse

00/00/0000

540 E 200 S
Salt Lake City, UT 84102

(801) 366-0000

ursmember@somewhere.com

Email Address

Mailing Address

Calculators ~




Tier 2 New Hire Checklist

Q{ Create account i

» Add beneficiaries

(primary and contingent)

from most screens

e You are receiving your tax documents and/or statements by mail. Switch to paperless.
My Profile Overview

Change Address and Phone Number Beneficiaries

Security You have made changes to your beneficiaries. You will lose any changes when you leave this page

unless you submit the changes.

Submit Changes Discard Changes

n Read this important information before updating your beneficiaries.

Paperless Preferences

Change Marital Status and Spouse Info.

Adivorce or annulment revokes your designation of a former spouse as a beneficiary. If you wish
redesignate your former spouse as a beneficiary, update your beneficiaries after the date of divor

Retirement System f m

You have not added any beneficiaries for this plan.

i 3

You have not added any beneficiaries for this plan.




Tier 2 New Hire Checklist

o Go to urs.org

» New Members section

» Watch videos: “Hybrid or 401(k)? A Quick Overview” and “Hybrid or 401(k)? A
Detailed Discussion”

» Review applicable brochure




Tier 2 New Hire Checklist

o Go to urs.org continued

» New Members section
» Education

» Videos tab:

» Watch: “Member Basics...”

A Big-Picture Overview
for Maximizing Your Benefits




Tier 2 New Hire Checklist

Q{ Choose to save

)

v

Is there a match? Be sure to ask your employer

» URS: no sales commissions and costs are low

v

)

v

Roth IRA = pay taxes now, tax free in retirement

)

v

401k, 457, Traditional IRA = no tax today, taxed in retirement

®&URS
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Tier 2 New Hire Checklist

Q{ Choose to save continued

» Investment Options and Savings Plans
brochure (Publications tab)

. . W ®URS
» Details on savings plans and o S
investments ' Howdoll...
» Roll over old retirement accounts S?JIAOver
: ccounts
» Watch our how-to video
to URS? .

» Contact Savings Plans Department:
801-366-7720




Tier 2 New Hire Checklist

o Attend live group presentation

» In-person or virtual
> Learn more about the Tier 2 choice
> Ask questions

» One year to make a choice

» Hybrid is the default option

®&URS
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Tier 2 New Hire Checklist

o Learn more though the video library

» Continue learning Tier 2 Choice
» Recorded videos
> Upcoming webinars ®URS
> Multiple topics

Hybrid or 401(k) Option?
Understanding Your

Tier 2 Choice

N

Empowerment to make choices




Tier 2 New Hire Checklist

Q{ Meet one-on-one with a URS advisor

» Now better prepared to meet with a URS advisor
» Schedule a free appointment through myURS

» Choose an in-person or virtual session

®&URS
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About Those 2022 Investment
Returns...

Annualized Betums for zed Bwturns Amnualiced Returna for

mded Dec, 31, 2022°

Ended D, 3

B e S T TR e

Year Years Years Years Yeoars Year ‘Years Years Years Years
185% 188% 207% 18™ LT1% ST0LB3% -0.81% 1348 231N 30

Annusl Beturns for
Periods Ended Decen

Anmualized Returns for
Pariods Ended Dex, 31, 2022

A et gt 1.3 5 .10 .18
Year Years Yesrs Years Years Year Yeoars Years Ysars Years

FI623N D33 Q7R 403N 14T C1367% TTIN S6T 996% BT

Annsisl Betarn Anmual Returns for
@ wiled Deecem ber 31 Periods Endied Decembser 31

nsm

Amnual fie g Armesl feturr
Perinds Ende mber 31 Periods Ended D

185 g s g s 7 ATV s g

1516 17 18 19 20 1 13 14 15 16 17 18 19 30 21 22

Rizk ! Reward

Rizk ! Reward




2022 Versus the Long-Term

US:SPX

D DISPLAY TOOLTIP

4,000
3,000
2,000

1,000

2002 2004 2006 2008 2010 2012 2014 2016 2018 2020 2022

®URS

Chart from marketwatch.com, Market over the past 20 years ks Refirenenlystems

€




URS Retirement Savings

» Available at urs.org under the QURS
Publications tab Investment Options
» Ask your advisor to presentto e T e e "

your employees

» Invest for the long-term

» Stay the course




Automatic Enroliment

» Nudge to improve retirement preparation
» Good, no-cost policy

)

v

Employee can change at anytime

» Matching contributions? Simple way to increase participation

LA

®URS
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Automatic Enroliment

How to implement (see handout)

» Employer

» Implement your internal policy
» Disclosure form for employees to sign (opting in or out)

» Completes new URS Service Agreement

» Start deducting from employee paycheck based on chosen start date

®&URS

Utah Retirement Systems




Automatic Enroliment

How to implement continued (see handout)

T p I Oyee Automatic Enrollmert
HELP YL EMPLOY L0

» Signs initial authorization
» Always 100% in control of savings amounts
» URS \

» Provides model documentation to employer

» Records new Service Agreement
®URS

Utah Retirement Systems




Value of the URS Benefit

Quarterly customizable messaging

» Template sent to agencies
» Allows for agency specific customization
» Highlights rich employee retirement benefit

» Focuses attention on employer paid benefit

®&URS

Utah Retirement Systems




Utah Code: Title 49

URS Education is So Important!

4 N

COMPREHENSIVE EMPLOYER TRAINING

RETIREMENT BASICS PLUS TRAINING

MONTHLY WEBINARS

4 )
KNOWLEDGE CORNER: ARCHIVED TRAINING VIDEOS
\ v
( )
EMPLOYER GUIDE
\ v

N
/

INSIDE STORY: QUARTERLY URS NEWSLETTER URS
v

Utah Retirement Systems
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Trust - Commitment
Value - Innovation - Excellence
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